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Welcome to 2020DOC
2020DOC is the software tool used for setting up a documentation management system and is an integral part of any 
institution’s data management workflow. 2020DOC automates the conversion of paper documents to electronic documents 
for fast retrieval while minimizing storage space and providing accessibility of all documents across a network. Documents 
such as loan contracts, signature cards, employee records and client correspondence are scanned and stored in a customized 
database. An institution can scan any item that needs to be stored on a short or long term basis. 

Main Menu Bar and Menu Buttons
This User Guide contains basic instructions for working within the 2020DOC environment. Throughout this manual, the 
user will be directed to use commands or functions on the Main Menu Bar or Menu Buttons. Clicking on, for example, 
the command File in the Main Menu Bar displays a dropdown submenu with subcommands or subfunctions. 

Access to the Main Menu Bar commands and their subcommands is dependent on the permissions assigned by the 
administrator and the items selected in locations. If the menus appear differently in the dropdown submenus of the Main 
Menu Bar than what appears in the sections that follow, it is a result of the assigned permissions or content. The Menu 
Buttons duplicate many of the functions seen in the Main Menu Bar but offers easier accessibility. 

Create a table, define field names and index criteria.
Scan documents into a table.
Import documents into a table.
Export documents and index information.
View Documents.
Search index information.
Print documents.
Email documents.

Users of 2020DOC will be able to perform some or all of the following functions depending on their assigned permissions.
Only assigned administrators are allowed to edit permissions in Users and Groups. If a menu command or sub menu 
command is not highlighted when a user tries to access (grayed out), it means that the user did not receive permission 
from the administrator to perform the task. 

Main Menu Bar
Menu Buttons
Other eDOC 
applications 
installed on the 
workstation

For users of eDOCSignature, an additional dropdown box will be visible in the righthand corner of the menu. This 
dropdown will allow the user to select between different parts of the document.  
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Launch the software by double clicking on the  on the home screen. Users will be prompted to a log-in screen. Once 
logged in, the Table Data window will open.

Launch Software

From the left pane of the screen highlight the Cabinet tab and table. The table data for that folder will appear in the right 
pane of the window.

Table Data

Understanding 2020DOC
Documents are created, deleted, and stored in two types of locations, private Local 
locations and shared Network locations. The Local location contains a set of Borland 
Database Engine (BDE) cabinets nested under My Cabinets. The Network location 
contains a set of SQL cabinets nested under the server host (network server name or 
IP address). 

Private Local Locations – These locations can be used for scanning, importing, 
and indexing documents before they are moved to the network for shared access. 
Performing these operations locally can help ensure that all documents are accurately 
captured and indexed before they are published to a shared network location. 

Shared Network Locations – These locations should be used for all long-term 
document storage. Documents stored here include items that are scanned using 
one of the eDOC Innovations supported scanners. 
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Scan
A scanning device must be installed before any scanning can be performed. 

To scan a new document, select a location where the scanned documents will be placed. Click Scan from the Menu Button.

To scan into an existing document, open the document in view mode and click Scan from the Menu Button.

Double click on an item in the table to open the document, or highlight the table and select the Document tab. The selected 
document will open in the right pane of the window.
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Scan Sequence
When the Acquire window opens, choose the scanner and select scan options for the documents. If this is a new document, 
the user will have the option to specify the index information. If this is an existing document, specify where the newly 
scanned pages will be added.

Click either Scan or Advanced. Choosing advanced will display the scan driver’s own dialog to allow a user to select 
advanced features provided by the scanner.

As documents begin to scan, each scanned page will be displayed in the preview pane. Click Cancel at any time during 
the scanning process. However, it should be noted that some scanners do not respond immediately to the cancel request.

When the document has finished scanning, click Close on the scan window to return to the 2020DOC main page. The 
newly scanned documents will appear in the document list at this time.
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Index Documents
Once documents are scanned or imported, they must be indexed for later retrieval.

To begin indexing, highlight the table in the left window pane that contains the documents to be indexed.

The contents of this table display on the right pane of the application window. Double-click the first record that needs 
indexing or select it and click the Document tab.

The document opens for viewing and the index fields appear on the left for entering information.
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Split Documents
Once documents are scanned, they may be divided into smaller documents for further processing. Click Split on the 
Menu Buttons to open the Split Document window.

To split a document, select from the Existing Document window the page/s for the new document, then click Create New 
Document. Pages may be replaced in the Existing Document window by checking Copy pages instead of move. The 
order of the pages in the New Document may be changed by shifting the documents into place.

To apply index information to the new document, copy data from the existing document or add new information manually. To 
copy the index information from the existing document, check the fields from the existing document’s index table. These fields 
will be applied to the new documents index table automatically. To apply new index information manually, uncheck the fields 
from the existing document’s index table and type in the new index information in the corresponding fields for the new document.
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Import Documents
To import documents into a selected table, click Import on the Menu Bar or select File | Import Documents.  A window 
will open with a header that reads Import documents into...(the selected table). Select the file and click Open. The file 
will import into the table.

To fill the blank fields in a document from an associated Master database, select a Trigger Field and click Fill From Master.
 
The Trigger Field must match the information as seen in the Split Document window. Once these two fields are validated, 
the application will fill in the remaining fields that correspond to the Master database.

Trigger Fields
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Importing a Text File to a Table
Import Text File to Table allows a user to add text files external to 2020DOC into tables inside 2020DOC.

From the File Menu, select Import Text File to Table...  This will open the Import Comma Delimited Text File to Table 
window.

Click on the ellipsis button in Text File box. This 
will open the Select Imput File window. Navigate 
to the text file to import and click Open.

The information from the file will automatically 
populate into the Text File and Text File Contents 
boxes of the Import Comma-Delimited Text 
File to Table box. Verify Text File Contents 
and Delimiter. Check First Line of Input File 
Contains Field Names if applicable.



2020DOC User Guide

12

The Insert into Table lists all of the SQL tables that are available for importing. If importing into a table, select the table 
from the dropdown.

Clicking Advanced Table View opens the View Doc Table window to view selected table and its fields. Click Close to 
exit back to the Import window.

To add to a table, select Add records to existing table. To create a new table, or to replace all data in a table, select 
Start a new table.

Data Fields/Order are the data fields that will be populated from the index file. These fields must be in the order that the 
data is in in the index file. Available Fields are the fields in the destination table, plus some default fields.

Modify Fields and specify Date and Time Format for the file to be imported. 

The Path to image file ellipsis will open the Select Image Files Directory window.

Make other selection as needed from the Import Comma-Delimited Text File to Table as needed. 

Clicking Import File will open the View Doc Table which will show the documents and fields that will be imported.  After 
reviewing, click Close.

Clicking Close on the the Import Comma-Delimited Text File to Table will return the user to the main program window.
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The purpose of the TIFF Combiner is to generate compatible index and image files for single page TIFF images or from 
image files that have index information in the file name. TIFF Combiner operates on two different file types. Select Use 
Index File for a file type ending in.csv (mytestindex.csv) . Select Index Info In File Name for a file type ending in.tif 
(acctnum_lname_fname_ssn.tif).   

A CSV file (comma-separated values) stores tabular data (numbers and text) in plain-text form. A CSV file consists of any 
number of records separated by line breaks of some kind. Each record consists of fields, separated by some other character 
or string, most commonly a literal comma or tab. Usually, all records have an identical sequence of fields.

A TIFF file (Tagged Image File Format), saved with the file ending .tif, is a file format for storing images.

Clicking  on the TIFF Container opens the Combine Images and Index Data window. Select Use Index File if the files 
to be imported have an associated index file. Select Index Info In File Name if t if the filename of the files to be imported 
contain the index information.

TIFF Combiner
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Click on the Original Image Index File ellipsis button to open the Select Image Files Directory. Browse to the location of 
the original image index file. Click on the New Image Index File to locate where the new image index file will be placed. 

Verify or enter Field Delimiter and Image Page Delimiter. Check Skip First Line of Index File if the first line of the file 
are headers.

Click Combine to merge multiple image files into a single image file and create a new index file with the new image file 
name. The new index file name should be the filename found in the index file with the same extension as the index file 
(i.e.  filename1.001, filename1.002, filename1.003).

Click Close to exit the Combine Images and Index Data window.

Clicking on the ellipsis buttons 
will open the Select Image 
Files Directory window where 
users can select a path.

Import a Check Database
Import Check Database allows a user to import a check database. To import a check database, such as Fed Checks, 
select the Cabinet (BDE) where you want the database to be placed. Select File | Import Check Database and browse 
to the location of the database file (.DBF) to be imported.
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Once the data has been imported, a Confirm window appears to remind the user to validate the import.

The Import window will open with the name of the database and the field data. These can be modified, but EDI recommends 
that you do not do this. Click OK to begin the import. The Importing … window will show the progress of the import.

When reviewing the import, if the data did not come through properly, the database can be restored to its previous version 
by selecting File | Rollback Check Import.
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Performing OCR
Once documents are scanned, optical character recognition (OCR) may be performed on any part of a page, on a full 
page, or on a document.

To OCR an area on a page, in the Document view select the OCR button then draw a box around the area.

To draw a box around an area, place the cursor at one corner of the data and then hold the mouse button down and draw 
diagonal to the opposite corner of the data. When the mouse is released, the box is completed and the data inside will be 
recognized.

After the data has been recognized, an arrow with the OCR button will appear. Put the arrow on the field where you want 
the OCR data to be placed and click the left mouse button. To OCR an entire document or a single page, open the document 
then click on the OCR menu in 2020DOC.  There are four options.

First Page will OCR only the first page of the document.
Document will OCR the entire document.
Template allows the user to select a pre-defined template to use to OCR the document.
Create / Modify Template… allows the user to create or modify a template that will be used by the Template option when 
running OCR on a document.
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When OCR has been used to read a full page or document, the screen will split horizontally showing the OCR 
text below the image.  The  allows the user to push the screen down and hide it below the original image.  The   

  button will delete the OCR text.

To change the size of the window, place the mouse on the line separating the image from the OCR text and then click to 
move up or down making the screen larger or smaller. 
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Open the document to use as the template and click the OCR menu and choose Create / Modify Template…

To modify a specific template chose it in the dropdown, make changes then click the Save button.

To delete a specific template, choose it in the dropdown then click the Delete button.

To create a new template, type the new name for the template in the Templates dropdown and make changes. Click Save 
to save.

To specify the field location, click the Clear button below the field name then draw the box on the form in the location 
where that data should be pulled from.  Repeat process for all applicable fields.

To add a new field, use the Add Field button. To remove a field, click the Delete Field button.

When all changes are complete click the Save button and close the window to return to 2020DOC.

Setting up an OCR Template
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Move / Move All

Expand All opens all subfolders in the directories.
Collapse All reduces the view to directories only.
OK moves the selected record/s to the high-lighted table in the window.
Cancel ends the Move operation and returns you to the Main Menu.

After clicking OK, the Confirm dialog box opens. Click Yes to complete the move.

The Move / Move All option works in both the Document Tab and the Cabinet tab. In the cabinet tab, the Move button will 
move any highlighted document and the Move All button will move all documents in that table.

To move a record, open a table and select the record and click Move. (Multiple records are selected by holding down the 
Ctrl key and clicking on additional records.) If you want to move the entire contents of a table, select Move All.
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If the record you are moving has fields that are not in the table you are moving to, you will get a warning. Make sure you 
want to discard the fields listed before selecting Yes. 

Discarded fields are not retrievable. Yes completes the move. No cancels the move and return you to the application.

Delete Documents
To delete a document, highlight the document and click Delete.

A warning window appears. Click OK to complete the deletion. Click Cancel to cancel.

Once deleted, a document cannot be recovered.

To delete multiple documents, hold down the Ctrl button on your keyboard and highlight the documents by clicking on the 
documents to be deleted. Click Delete.
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Create Table in My Cabinet (BDE)

Create SQL Tables
Highlight one of the existing Cabinets and select File. Scroll to Create Table. This opens the Document Tables window.

Document tables are tables that hold all the index information for the images stored in the 2020DOC program. 

To create a table in a My Cabinet, select File and scroll to Create Table.  The Create Table in C:\LOCAL CABINET\ 
window will open. 

Name the table and scroll to the Master Table text box to be used. In Fields enter the Name, Type, Index, and Length 
of each field that is to be included in this table. The field types/lengths should match local cabinet (BDE) table types for 
scanning/moving. When moving from a local table to a SQL table if they do not match exactly the data in the field will be 
lost. Click OK.
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Document Tables

Adjust and Move Field Size 
Fields may be adjusted by moving the right column line of a field in the table’s header. Roll the mouse over the line until 
the movement arrow appears ←||→. Left click the mouse and the line will become bold. Hold down while dragging to the 
desired location.	  

To move a field, left click the mouse on the header of the field. The line will become heavily bold. Move the field to the 
right or left to change the location of the field.

Sort a Column
To sort the column in ascending order, right-click the mouse on the column header.

To sort the column in descending order, right-click the mouse on the column header again

Select Create Table from the File menu. Enter the name of the new table.

Select the Document Type. 

The Document Category is assigned as part of the Document Type. For most documents, the document category will be 
Image. If a table is created to scan documents into and a different category is chosen, the function may not work properly. 
The other categories are used for different functions in the software. See page 21 Document Type for more information. 

Select a Master Table.*

A date range will limit the dates of the search.

Check Make available to web users to make this document usable in other eDOC Innovations web programs.

Click the down arrow to select the Default Location (default image location). To create a new location, click the ellipsis 
button. This will display the Modify Location IDs window where you may Add a location.

Select the Cabinet to store this table. To create a new cabinet click the ellipsis button. This will display the Add or Delete 
buttons. Add a cabinet. Click Save to save changes or Reset to reset information.

Document tables are tables that need to be created to hold all the index information for the images stored in the 2020DOC 
program. Best practice is to have every table use its own unique default location (one per table).
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Fields display in the User Fields In This Document Type box.

Key		

Move Up 		  Moves a field up in the list.
Move Down		  Moves a field down in the list.
Remove		  Deletes a field from the list.
Defined Fields 		  Select the fields to use with this document type from the Defined Fields window by 		
		   	 highlighting the field and then clicking the < (left arrow). To create a new Defined Field 		
			   refer to the Defined Fields section immediately following this section.
Edit			   Allows changes to the field selected.
Add 			   Displays Field Definition window to add a new field.
Delete			   Removes a field up from the list.

Click Save to preserve the changes, Reset to start over, or Close to exit the window. The saved new Document 
Type is now available in the Document Tables window.

Document Type
Every table created needs an associated Document Type for indexing and searching.

Select Manage from the Main Menu. 
Select Tables. The Document Tables 
will open. Assign a name in the Create 
New Type box.

Click on the browse (ellipsis) button and 
the Document Types window will open. 

Select the down arrow on Document 
Category to display options.

Image for most document types.
Multi-Image for future enhancement.
Check Image for all imported check 
tables.
Report for future enhancement.
Statement for Email 4 Statements.
Multi-Check for CheckLogic scanned 
checks.
Customer-Check for customer check.

Select the cabinet to store this table in by clicking the down arrow. This is the cabinet 
where selecting specific fields as a Key value will index the data to provide much faster 
searching on documents. An example would be selecting the Account, SSN, and Last_
Name as Key values. To set a Key value, double-click the left mouse button inside the 
Key column across from the field Name that is to be a Key value.
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VARCHAR	 Variable number of characters up to 255 characters.* 
CHAR		  Fixed number of characters up to 255 characters.* 
DATE		  Inputted into 2020DOC as MM/DD/YYYY store in SQL as YYYY-MM-DD.** 
TIME		  Allows for time inputted as HH:MM:SS.** 
DATETIME	 Both date and time as stated above.** 	
TEXT		  Allows for very large fields of text up to 65535 characters.** 
SMALLINT	 Allows for number inputted between the values of -32768 to +32767.** 
INTEGER	 Allows for very large numbers between the values of -2147483648 to +2147483647.** 
DECIMAL	 A floating point number. It is necessary to enter a size and precision. A size of 12 and a precision 		
		  of 2 is often used for currency.
REAL		  Used for currency.*** 	
OPTIONS	 Allows creation of a list of values to select from.
Size		  Field length. (10 would define a field length of 10 characters.)
Precision	 The number of decimal places in the number. Currency often uses two decimal places.

   *Required to enter a size but precision is not required.
  **Not required to enter a size or precision.
***Required to enter a size and precision

To add a new Defined Field, from the 
Document Type window click the Add 
button. Enter a Name and select a Type.	

Click Save to preserve the changes and 
exit, or Cancel to exit without saving.

Edit allows changes to the field selected.
Delete removes a field up from the list.

The saved new Document Type is now 
available in the Document Tables window.

Defined Fields

Edit Menu
Undo typing 	 Removes information typed in the notes field of a record that 	
		  displays in Document view.
Cut		  Removes highlighted material and saves it to the clipboard.
Copy		  Saves highlighted material to the clipboard.
Paste		  Inserts saved material at the cursor location.	  
Select All	 Highlights all documents in the open Cabinet.	  
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Print and Printer Setup
From the File menu select Print. 
Selecting Print | Document … prints the 
selected document. Selecting Print | List 
… prints a list of all the documents in the 
table

Once the print selection is made, the 
Print window will display. Print range 
and number of copies may be specified. 
Properties may also be modified.
Select OK to print or Cancel to return to 
the main menu.

Printer Setup opens the operating system 
Print Setup window. At this window 
and the windows available through the 
buttons, all properties of a printer may 
be specified. The content of this window 
varies depending on the installed printer. 
Refer to your printer manual for help.

Tools Menu
Configure in the Tool Menu searches parameter-based searches usually used with the Command Line Interface API. 
Refer to 2020DOC Administrator Guide Appendix B for more information on parameter-based searches and 
Command Line Interface API.

Page Menu
The Page Menu can open with one or all of the following commands. 

Cut 			   Removes highlighted material and saves it to the clipboard.
Copy			   Saves highlighted material to the clipboard.
Delete			   Permanently removes document being viewed.	  

Paste			   Inserts saved material according to selection.
Before page 1		  Inserts clipboard material before the first page.
After page 1		  Inserts clipboard material before the second page.
As new document	 Inserts clipboard material into a new document.	  

Count All		  Counts the number of pages in selected document.



2020DOC User Guide

26

Email Documents
Users can email the current document they are in 
by simply selecting Email on the Menu Buttons. The 
user’s default email will pop up. The user also can 
add attachments to the email.

A drop-down menu will open using Email on the 
Main Menu where you will have the following 
options:

Customer Data
Message Format
Marketing Segment
Email Settings

Search Menu
Click on Search to find information in localhost (MySQL) tables. 

From the Tables window select the table/s to be searched.

From the Fields window select the field/s to be searched.
 
If the field you have chosen is a text field, enter the text criteria you want to search on in this window.

If the field you have chosen is a date field, enter the date criteria you want to search on in this window.	  

If the field you have chosen is a numeric field, enter the numeric criteria you want to search on in this window.

Note: eDOC Email Manager Application must be installed on the server to manage the ending of the documents. Members 
also must have a PIN number established before sending the document or the document will be sent unencrypted.  To 
add a pin use the Email Customer Data screen. 
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Log out and Exit
Log out exits the program and displays the Login User 
window. At the Login User window a user must Login or 
the program will close.

Exit closes the 2020DOC program.

Customer Data allows the user to Print, Pack, 
Marketing Import or Export customer data.

Message Format allows the user to select 
type of document and allows attachments and 
marketing segments.

Marketing Segments are inserted or deleted 
based on customer interests.

Email User Settings can be customized 
for Notification of Errors and Customer Data 
Changes.
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Need Help?
Clicking on Help > About opens the Splash 
screen where the product name and version 
number is recorded. If you need assistance 
with the software a Customer Service 
Representative is waiting to assist you.

Customer Service Representatives 
can be reached at 800.425.7766

2020DOC Partner Programs

ArchView – automated backup functionality.
CheckLogic – Check 21 capture.
ProDOC – individual form and receipt capture.
2020eDOC – internet viewing of account information.
2020iDOC – internet browsing of 2020DOC system images.
idocVAULT – automated storage and recall of electronically captured receipts.
DocLogic Desktop – integration of all EDI products.

2020DOC is often used in conjunction with one or more eDOC Innovations capture products. If your menu Button 
has other icons after the Delete button, other programs have been packaged with your 2020DOC. The example 
below shows the added menu buttons, ArchView and Statement Admin that have been packaged with 2020DOC. 
Clicking on these icons will launch the program. Please refer to their User Guide manual for further information.



2020DOC User Guide

Last technical update 05/19/16 29

INDEX

Symbols
2020DOC Partner Programs  28

A
Adjust and Move Field Size  22

C
Cabinets

Create Table in My Cabinet (BDE)  21
Create a Document Type  23
Create / Modify Template…  16
Create SQL Tables  21
Create Table in My Cabinet (BDE)  21

D
Defined Fields  24
Delete Documents  20
Documents

Create a Document Type  23
Document Tables  22

E
Edit Menu  24
Email Documents  26
Exit  27

F
Fields

Adjusting and Moving Field Size  22
Defined Fields
Sort a Column  22

H
Help  28

I
Import Documents  10
Importing a Check Database  14
Index Documents  8

L
Launch Software  5
Log out  27

M
Main Menu Bar and Menu Buttons  4
Move / Move All  19

O
optical character recognition (OCR)  16

P
Page Menu  25
Performing OCR  16
Print and Printer Setup  25

S
Scan  6
Scan Sequence  7
Search Menu  26
Setting up an OCR Template  18
Sort a Column  22
Split Documents  9

T
Table Data  5
Tables

Create SQL Tables  21
Create Table in My Cabinet (BDE)  21

Tools Menu  25
Trigger Fields  10

U
Understanding 2020DOC  5

W
Welcome to 2020DOC  4


	Welcome to 2020DOC
	Main Menu Bar and Menu Buttons
	Understanding 2020DOC
	Launch Software
	Table Data
	Scan
	Scan Sequence
	Index Documents
	Split Documents
	Trigger Fields
	Import Documents
	Importing a Text File to a Table
	TIFF Combiner
	Import a Check Database
	Performing OCR
	Setting up an OCR Template
	Move / Move All
	Delete Documents
	Create Table in My Cabinet (BDE)
	Create SQL Tables
	Document Tables
	Adjust and Move Field Size 
	Sort a Column
	Document Type
	Defined Fields
	Edit Menu
	Page Menu
	Tools Menu
	Print and Printer Setup
	Search Menu
	Email Documents
	Log out and Exit
	2020DOC Partner Programs
	Need Help?
	INDEX


